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Predgovor 

Današnje društvo obilježeno je naglim rastom i razvojem informacijske 

tehnologije (IT), što je rezultiralo velikom ovisnošću društva, u širem smislu, 

o znanju i kompetencijama osobe u IT području. I premda ta ovisnost raste 

iz dana u dan, ljudsko pravo na obrazovanje i informacije nije prošireno i 

na IT područje. Pojavili su se problemi koji utječu na društvo u cjelini, koji 

stvaraju prepreke i udaljavaju ljude od glavnog razloga i motivacije za 

napredak, od prilike. Danas, biti računalno nepismena osoba, znači biti 

osoba koja nije u mogućnosti sudjelovati u modernom društvu, osoba bez 

prilike, i unatoč priznatoj neophodnosti i korisnosti inkluzivne informatičke 

pismenosti, od strane Europske komisije, UNESCO-a, OECD-a i ostalih 

relevantnih institucija, još uvijek postoje grupe ljudi sa otežanim pristupom 

osnovnoj računalnoj naobrazbi (npr. osobe s invaliditetom, osobe s 

poteškoćama u učenju, radnice/i migranti, nezaposlene osobe, osobe koje 

žive na udaljenim mjestima gdje nemaju pristup računalnoj edukaciji). 

 

Ove skripte, zajedno sa ostalim materijalom objavljenim na stranici 

ITdesk.info, predstavljaju naš doprinos realizaciji i promociji ljudskog prava 

na edukaciju i informacije u IT području. Nadamo se da će Vam ova 

edukacija pomoći u savladavanju osnovnih računalnih vještina i s tom 

nadom želimo Vam da naučite što više i tako postanete aktivni/a član/ica 

modernog IT društva. 

 

Iskreno Vaši, 

 

ITdesk.info team 
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MICROSOFT EXCEL 2010 BETA – ELEMENTI SUČELJA 

 
 

1. Gumbi za manipulaciju prozorom – minimiziranje, maksimiziranje, zatvaranje prozora 

2. Naslovna traka – ime dokumenta, ekstenzija ili nastavak (.xlsx) te ime programa 

3. Kartice / tabs 

o Datoteka / File 

o Početna / Home 

o Umetni / Insert 

o Izgled stranice / Page Layout 

o Formule / Formulas  

o Podaci / Data  

o Prikaz / Review 

o Pogled / View 

4. Traka s alatima / Toolbar 

o neke skrivene naredbe, imaju strelicu pokraj za otvaranje dodatnih opcija  

o zasivljene naredbe se ne mogu trenutno izvršiti  

o naredbe s tri točke imaju slijed daljnjih naredbi 

 kartice i alatne trake zajedno se nazivaju vrpca (ribbon) 

5. Označene ćelije – ovdje unosimo tekst, broj, „Sparkline“ (grafikon unutar jedne ćelije) 

6. Naslovi stupaca (slova) 

7. Naslovi redaka (brojevi) 

8. Radni listovi 

9. Trake za horizontalnu i vertikalnu navigaciju (klizači) 

o dvostruka strelica gore/dolje prebacuje pogled za jednu stranicu više/manje 

10. Statusna traka - prikazuje stanje nekih posebnih funkcija Microsoft Excel-a  

11. Traka za unos formula 
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Radna knjiga:  - datoteka Microsoft Excel-a,  sastoji se od radnih listova 

Radni list: - sastoji se od velikog broja stupaca i redaka koji križanjem tvore ćelije 

Ćelija:  - osnovni element u Excelu, u njih unosimo sadržaj (tekst, broj, formula) 

 - adresa ćelije: slovo stupca i broj retka, npr. A1, C7 

 

Označavanje ćelije - pritisnemo lijevu tipku miša na ćeliju. 

Unos sadržaja – označimo ćeliju i upišemo tekst. 

Dodavanje sadržaja u ćeliju – dva puta pritisnemo lijevu tipku miša na ćeliju i unesemo dodatni tekst. 

Izmjena postojećeg sadržaja - označimo ćeliju koju želimo izmijeniti i unesemo novi tekst. 

Decimalni brojevi se odvajaju točkom, a ne zarezom. 

Brojevi se poravnavaju po desnoj strani, a tekst se poravnava po lijevoj strani. 

Ukoliko uneseni sadržaj nadmašuje širinu ćelije bit će ispisan preko susjednih ćelija ukoliko u njima 

nema unosa. 

 

Promjena položaja točke umetanja: tipka TAB,  strelice na tipkovnici, pritiskom lijeve tipke miša u 

željenu ćeliju. 

 

Označavanje raspona ćelija: 

 označimo prvu ćeliju u rasponu, pritisnemo i zadržimo lijevu tipku miša, prijeđemo mišem do 

zadnje ćelije željenog raspona te otpustimo lijevu tipku 

 označimo prvu ćeliju u rasponu, pritisnemo i zadržimo tipku Shift, označimo zadnju ćeliju u 

rasponu te otpustimo tipku Shift 

Označavanje retka ili stupca: pritisnemo lijevu tipku miša na broj retka ili slovo stupca. 

Označavanje niza susjednih redaka: pritisnemo lijevu tipku miša na broj retka, pritisnemo i zadržimo 

lijevu tipku miša, prijeđemo mišem do zadnjeg retka te otpustimo lijevu tipku (ili tipkom Shift). 

Označavanje niza nesusjednih ćelija, redaka i stupaca: pritisnemo lijevu tipku miša na broj retka, 

pritisnemo i zadržimo tipku Ctrl dok ne pritisnemo lijevom tipkom miša na ostale ćelije, retke. 

 

Preimenovanje radnog lista / Rename sheet: 

 Pozicioniramo se na radni list > Format > Rename Sheet > unesemo ime > Enter; ili 

 Pritisnemo desnu tipku miša na karticu lista > Rename 

 

Kopiranje i premještanje lista unutar i između radnih knjiga (knjige moraju biti otvorene) 

1. pritisnemo desnu tipku miša na karticu lista > Pomakni ili kopiraj list (Move or Copy Sheet) 

2. u dijaloškom okviru odaberemo u koju radnu knjigu želimo premjestiti, a u dijelu Before 

sheet odaberemo prije kojeg lista > OK 

Ukoliko želimo kopirati treba uključiti Kreiraj kopiju / Create a Copy, inače će se list premjestiti. 

 

Brisanje sadržaja ćelije - označimo jednu ili više ćelija (pomoću tipke Shift ako su u slijedu, a Ctrl ako 

nisu) i  pritisnemo tipku Delete. 

 

Poništavanje izmjena (Undo) i poništavanje poništavanja izmjena (Redo) 

Poništi (Undo)     Ponovi (Redo)  

Pritiskom na strelicu pokraj alata otvara se padajući izbornik sa listom svih akcija koje smo napravili. 
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IZBORNIK: DATOTEKA / FILE 

 

Alat Spremi (Save)  (prečica na tipkovnici Ctrl + S) 

 Spremi u / Save in - u koju mapu će se datoteka spremiti 

 Ime datoteke / File name - upišemo naziv datoteke 

 Spremi kao tip / Save as type – program u kojem spremamo dokument  

Stvaranje nove radne knjige: Novo > Prazna radna knjiga > Kreiraj  

(New > Blank workbook > Create) (prečica Ctrl + N). 

Olakšano je kreiranje nove datoteke korištenjem predloška – ekstenzija ili nastavak .xltx. 

Stvaranje radne knjige prema predlošku: File > New > Sample Templates. 

Otvaranje postojećeg dokumenta  - alat Open (otvaranje više dokumenata: tipka Ctrl ili Shift). 

 

Ispis / Print: 

 Printer – odabiremo pisač 

 Copies – broj kopija dokumenta 

 Range: 

o Ispis aktivnih listova / Print active sheets   

o Ispis cijele radne knjige / Print entire workbook   

o Ispis odabranog / Print selection 

 Orijentacija / Orientation: portret / Portrait, krajolik / Landscape 

 Margine / Margins:  - Normalne / Normal - Uske / Narrow  - Široke / Wide 

 Skaliranje / Scaling: 

o Bez skaliranja / No scaling  

o Podesi list na jednu stranu / Fit sheet to one page   

o Podesi sve stupce na jednu stranicu / Fit all columns to one page 

o Podesi sve retke na jednu stranicu / Fit all rows to one page 

 Collated – ispisuje se cijeli radni list od početka do kraja, a zatim prema zadanom broju 

kopija; Uncollated – ispisuje se prva stranica prema zadanom broju kopija, zatim druga itd. 

 Page setup – Stranica / Page – na padajućem izborniku odabiremo veličinu papira i sl. 
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 Margine / Margins – ručno podešavanje margina 

 Zaglavlje / Podnožje (Header / Footer) – u polja unosimo tekst, datum, vrijeme, ime  

 Listovi / Sheets – označimo raspon ćelija za automatski ispis naslova redaka / stupaca na 

svakoj stranici radnog lista 

Dijeljenje / Share - nove mogućnosti koje olakšavaju dijeljenje dokumenata: 

 Promijeni tip datoteke / Change File Type - snimamo datoteku u drugom programu 

 Kreiraj PDF/XPS dokument / Create PDF/XPS Document – snimanje datoteke u fiksiranom 

formatu, ne može biti lagano promijenjen 

Mogućnosti / Options > kartica “General” > sadrži polje za unos korisničkog imena 

> kartica Spremi / Save > polja za “AutoRecover file location” i “Default file location”  

 

KARTICA: POČETNA / HOME 

 
 

Vrsta slova (font): Times New Roman, Verdana, Ariel, Calibri itd. 

Veličina slova / Font Size – padajući izbornik    

 

Oblikovanje teksta     

Podebljanje (Bold) 
- Ctrl + B 

Zakošenje (Italic) 
-  Ctrl + I 

Podvlačenje (Underline)  
- Ctrl + U 

Bojanje teksta različitim bojama: alat Font Color  

Poravnanje teksta  – horizontalno:  

- vertikalno: Poravnaj: lijevo / Align Left, po sredini / Centar, 

desno / Align Right, obostrano / Justify 

Spoji i centriraj / Merge and center – alat koji spaja označeni raspon ćelija i centrira sadržaj 

 Orijentacija / Orientation – alat za određivanje smjera sadržaja u ćeliji 

 Omatanje teksta / Wrap Text – alat koji prilagođava sadržaj u nekoliko redova unutar ćelije da 

bi sav bio vidljiv 

 

 Oblikovanje broja / Number Format – određujemo vrstu unesenih brojeva 

- Povećavanje / smanjenje decimalnog mjesta -  Increase / decrease decimal 

 Uvjetno oblikovanje / Conditional Formatting – alat za određivanje uvjeta 

potrebnog da ćelija zadovolji, te  određivanje oblikovanja ukoliko zadovoljava određeni uvjet 
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 - Umetni / Insert – alat za umetanje ćelija, stupaca, redaka, radnih listova 

 - Obriši / Delete – alat za brisanje sadržaja i / ili oblikovanja ćelija, brisanje stupaca, 

redaka, radnih listova 

 

 
 Oblikuj / Format – alat za oblikovanje označenih ćelija, stupaca, redaka 

 Zaštita lista / Protect sheet – unesemo šifru te označimo radnje koje dozvoljavamo ostalim 

korisnicima 

 Preimenovanje lista / Rename Sheet > unesemo ime > Enter 

 Zaključavanje ćelija / Lock cell je omogućen ukoliko prethodno zaštitimo radni list 

 

UNOS FUNKCIJE: 

1. označimo raspon ćelija  

2. unesemo funkciju pomoću izbornika prikazanog ispod  

-  odabrana funkcija je unesena nakon označenog raspona ćelija 

Ili:  1. označimo ćeliju u kojoj želimo vrijednost funkcije 

 2. unesemo znak „=“ 

 3. direktno unesemo željenu funkciju (npr. „sum“ za sumu) 

 4. u zagradama upišemo raspon ćelija na koji želimo da se funkcija referira 

Najčešće funkcije: 

= SUM (raspon ćelija)  zbrajanje odabranih ćelija 

= AVERAGE (raspon ćelija)  srednja vrijednost raspona ćelija 

= MIN (raspon ćelija)  pronalazi najmanju vrijednost 

= MAX (raspon ćelija)  pronalazi najveću vrijednost 

 

Označimo ćelije, stupce, retke koje želimo obrisati i odaberemo opciju: 

 Brisanje svega / Clear All  

 Brisanje sadržaja ćelije / Clear Contents 

 Brisanje oblikovanja ćelije / Clear Formats 

 

 

Sortiranje tablice od najmanje do najveće vrijednosti (Sort A to Z), ili od najveće do najmanje 

vrijednosti (Sort Z to A), unesene u određeni stupac ili redak 

 

 

 Traženje određene riječi ili fraze - Nađi / Find, Upišemo frazu, Pronađi slijedeće / Find Next 

Zamjena određene riječi: Find What – koju riječ tražimo  

 Replace With - čime želimo zamijeniti 

Kopiranje oblikovanja s jednog dijela teksta na drugi,  alat Format Painter  

 

Pomoć u MS Excel-u -  Alat Help  , F1 na tipkovnici 
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KARTICA: UMETANJE / INSERT 

 

Likovi / Shapes   – nakon odabira jednog lika na radni list ga unosimo metodom uhvati-povuci-

pusti (drag-and-drop) čime mu automatski definiramo veličinu i položaj. 

Uredi / Arrange – razmješta elemente ispred (Bring forward) ili iza (Send to back) drugih likova.  

 

Ispuna lika  >         - otvara paletu boja  

Kontura lika  >         - otvara paletu boja , izbor vrste i debljine linije. 

Efekti lika   >         - ponuđeni efekti: 3D, sjena, odraz, rotacija, itd. 

 

Slike  

 označavanje slike radimo pritiskom lijeve tipke miša na željeni objekt, nakon čega objekt na 

obrubu dobije kvadratiće 

 podešavanje veličine objekta: 

o Ručno: označimo objekt, pomičemo neke od rubnih točaka na okviru objekta 

o Upisom vrijednosti: desni klik na objekt > Oblikuj sliku / Format Picture > kartica Veličina / 

Size       > unijeti vrijednosti za visinu (Height) i širinu (Width) 

 

Dok imamo označenu sliku možemo otvoriti izbornik Oblikuj / Format koji sadrži neke nove 

mogućnosti oblikovanja: 

       - alat za ispravke kontrasta, svjetline, izoštrenja 

      - promjena boja slike kako bi bolje odgovarala ostalom sadržaju 

      - alat kako bi slika djelovala kao crtež ili naslikana 

 

- alat za unos polja za tekst, nakon odabira alata metodom uhvati-povuci-pusti (drag and 

drop) određujemo mu položaj i veličinu na radnom listu 

 

 

Zaglavlje i podnožje (Header and Footer) 

 uređivanje: pritisnemo lijevu tipku miša u prostor zaglavlja ili podnožja, ili desni klik> uredi 

tekst / Edit text 

 

 umetanje datuma i vremena / date and time 

 umetanje broja stranice / page number 

 

Umetanje simbola     €   £   ©  ∞    ≠                itd. 
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Grafikoni     

 Grafički prikaz tabličnih podataka, grafikon i tablični podaci su povezani – promjene u tablici 

reflektiraju se na grafikonu 

 Odabirom alata za umetanje grafikona otvara nam se tablica u MS Excel-u za unos podataka  

 Promjena veličine grafikona- označimo grafikon i pomičemo kontrolne točke u željenom 

smjeru 

 Promjene na grafikonu možemo činiti preko alatne trake Chart Tools koja se pojavljuje kad je 

grafikon označen, preko brzog izbornika ili dvostrukim pritiskom lijeve tipke miša na grafikon 

 Oblikovanje područja grafikona / Format Chart Area - za dodavanje efekata ispune bojom, 

3D, rotacija, sjena, itd.  

 Promjena vrste grafikona / Change Chart Type > odaberemo vrstu  

 Pomicanje grafikona: na izborniku Chart Tools > Design > alat Pomakni grafikon / Move chart:  

> Novi list / New sheet (i polje za upis imena radnog lista) ili  

> Objekt na / Object in > na padajućem izborniku odaberemo na koji radni list ćemo smjestiti 

grafikon 

 

 

Organizacijski dijagrami, „SmartArt“  

 možemo premještati polja kako bi uredili strukturu: lijeva tipka mišem na okvir > uhvati-

povuci-pusti (drag and drop) na željeno mjesto 

 možemo dodavati okvire za unos sadržaja: označimo okvir kojem želimo dodati novi okvir, 

desnom tipkom miša pozovemo brzi izbornik > Add Shape te odaberemo ispod (below) ili 

iznad (above)  

 brisanje: označimo objekt i pritisnemo tipku Delete 

 

 

 

Sparklines – grafikon unutar jedne ćelije  

 trebamo mu definirati smještaj (adresu ćelije u kojoj se nalazi) i 

raspon ćelija koji će prikazivati  
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KARTICA: IZGLED STRANICE / PAGE LAYOUT 

 
 Margine:  - Normalne / Normal  - Uske / Narrow - Široke / Wide 

 Orijentacija / Orientation: Portrait (vertikalno) i Landscape (horizontalno)   

 Skaliranje / Scale: alat za smanjivanje ili povećavanje ispisnih podataka na određeni postotak 

stvarne veličine unesenih podataka 

 Prijelomi / Breaks - radi preglednosti poželjno je da sami postavimo prijelome  

o Umetni prijelom stranice / Insert Page Break 

o Ukloni prijelom stranice / Remove Page Break 

 Alati za organiziranje sadržaja: - Približi / Bring Forward 

- Udalji / Send Backward 

 

 

KARTICA: PRIKAZ / REVIEW 

 

Pravopis / Spelling  - otvara se dijaloški okvir sa opcijama: ignoriraj jednom, ignoriraj sve, 

promjeni, promjeni sve (Ignore once, Ignore all, Change, Change all) 

o riječ koja se ne nalazi u rječniku  možemo unijeti: pritisnemo desnu tipku miša > Add 

to dictionary 

  

 

KARTICA: POGLED / VIEW 

 
Korištenje različitih pogleda  

 Običan prikaz / Normal - namijenjen izradi radnog lista  

 Izgled stranice / Page Layout – za pregled ispisa: unesenog sadržaja, zaglavlja, podnožja 
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 Zumiranje / Zoom – odabir ponuđene ili unos vrijednosti 

 

Zamrzavanje i odmrzavanje redaka i stupaca da bi stalno bili vidljivi: 

 zamrzavanje i redaka i stupaca: označimo ćeliju koja se nalazi desno od stupca koji želimo 

zamrznuti i ispod retka koji želimo zamrznuti te odaberimo gumb Zamrzni okno / Freeze 

Panes 

 zamrzavanje redaka ili stupaca: označimo stupac koji se nalazi desno od stupca koji želimo 

zamrznuti ili označimo redak ispod retka koji želimo zamrznuti te odaberimo gumb Zamrzni 

okno / Freeze Panes 

 

FORMULE 

Formula može koristiti numeričke podatke i adrese ćelija (unesenu vrijednost u ćeliji) 

Unos formule: 

 označimo ćeliju u koju želimo unijeti formulu 

 unesemo znak = 

 unesemo numeričke vrijednosti ili adrese ćelija i aritmetički operator 

 tipka Enter za završetak 

 

Osnovni aritmetički operatori: 

 Zbrajanje:    =A1+A2 

 Oduzimanje:  =D5-D6 

 Množenje:  =A3*C5 

 Dijeljenje:  =C5/C3 

 Potenciranje:  =F15^A2 

 

Excel prati matematički redoslijed izračuna operacija, tj. prvo izračunava ono što je u zagradi. 

Formula se vidi u traci za formule kada označimo ćeliju, a u ćeliji vidimo rezultat formule.  

 

Relativne adrese (npr. C5) 

o kada se formula kopira samoispunom kopira se samo formula, a adrese se 

prilagođavaju ovisno o položaju ćelije u kojoj je formula 

Apsolutne adrese (npr. $C$5) 

o kada se formula kopira samoispunom kopira se formula i jedna adresa ćelije, a druga 

adresa se prilagođava ovisno o retku u kojem je formula (izračun poreza, tečaja itd.) 

o apsolutna adresa sadrži u sebi znak $ i to ispred naziva stupca i ispred naziva retka  

Promjena adrese iz relativne u apsolutnu: označimo ćeliju gdje se nalazi formula, u traci za formule 

lijevom tipkom označimo željenu adresu i pritisnemo tipku F4. 

 

Korištenje logične funkcije IF 

 Logična funkcija koja uspoređuje vrijednosti u ćelijama s nekim izrazom ili nekom 

vrijednošću. U ovisnosti s rezultatom definiramo akciju koju će funkcija izvršiti 
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 Sintaksa: 

o IF(logički_uvjet;vrijednost_ako_je_istina;vrijednost_ako_je_laž) 

o Logički uvjet – provjerava je li zadovoljen postavljen uvjet, te vraća izlaznu vrijednost 

ISTINA ili LAŽ (true or false).  

 

Logički operatori koje koristimo: 

 Veće > 
 Veće ili jednako >= 

  Manje < 
  Manje ili jednako <= 

 Jednako = 

 

Raspon ćelija se označava upisom znaka dvotočke između početne i završne adrese ćelija raspona, a 

argumenti u IF funkciji odvajaju upisom točke zareza. 
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Ova skripta je namijenjena za učenje uz materijale 

objavljene na slijedećim linkovima: 

 

 

* Priručnik: 

 http://www.itdesk.info/prirucnik_proracunske_tablice_microsoft_excel_2010.pdf  

 

 

* Video prezentacije koje prikazuju rad u Microsoft Excel 2010: 

 http://www.itdesk.info/hrvatski/microsoft-excel-1/ 

 http://www.itdesk.info/hrvatski/microsoft-excel-2/ 

 http://www.itdesk.info/hrvatski/microsoft-excel-3/ 

 

 

* Probni ispit:  

http://www.itdesk.info/primjeri ispita/primjer ispita modul 4.pdf  

 

 

* Video-prezentacija koja prikazuje rješavanje primjera ispita: 

http://www.itdesk.info/hrvatski/tablicne-kalkulacije-microsoft-excel-2010-video-rjesenje-ispita/  

 

 

* Kvizevi koji korisnici/ce sami rješavaju: 

 http://www.itdesk.info/hrvatski/tablicne-kalkulacije-kviz-1/  

 http://www.itdesk.info/hrvatski/tablicne-kalkulacije-kviz-2/  

 

 (za otvaranje linka koji se nalazi unutar .pdf dokumenta samo pritisnite lijevu tipku miša na jedan od 

navedenih linkova. Web stranica na koju link pokazuje će se otvoriti u Internet pregledniku koji imate 

instaliran na računalu.) 
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Opći uvjeti korištenja: 

 

Web stranicu www.ITdesk.info je pokrenula udruga „Otvoreno društvo za razmjenu 

ideja - ODRAZI“ u sklopu aktivnog promoviranja ljudskog prava na slobodan 

pristup informacijama te ljudskog prava na edukaciju. 

Slobodno kopirajte i distribuirajte ovaj dokument, uz uvjet da ne mijenjate ništa u 

njemu! 

Nad svim programima i uslugama navedenim na web stranici ITdesk Home na web adresi ITdesk.info 

isključivo pravo posjeduju njihovi autori/ce. Microsoft, Windows, i Windowsxx su registrirani zaštitni 

znakovi tvrtke Microsoft Corporation. Ostali zaštitni znaci korišteni na ITdesk Home Web stranicama 

su isključivo vlasništvo njihovih vlasnika/ca. Ukoliko imate pitanja vezana uz uporabu ili 

redistribuciju bilo kojeg programa, molimo kontaktirajte autore/ice dotičnog programa. Sva dodatna 

pitanja posaljite na info@itdesk.info.  

Ove web stranice sadržavaju linkove na ostale web stranice ili izvore. ITdesk.info team NIJE 

odgovoran za tekstualni i/ili reklamni sadržaj, odnosno za proizvode koji su na tim web 

stranicama/izvorima ponuđeni, kao što NIJE odgovoran niti za sadržaj koji je putem njih dostupan; 

mogućnost korištenja ili točnost sadržaja. Linkove koristite na vlastitu odgovornost. Također, 

ITdesk.info team ne garantira: 

 da je sadržaj na ovim web stranicama oslobođen od pogrešaka ili pogodan za svaku svrhu, 

 da će ove web stranice ili web usluge funkcionirati bez pogrešaka ili prekida, 

 da će biti odgovarajući za vaše potrebe, 

 da implementacija takvog sadržaja neće narušavati patente, autorska prava, zaštitni znak ili 

ostala prava neke treće strane. 

Ukoliko se ne slažete s ovim općim uvjetima korištenja ili ako niste zadovoljni web stranicama koje 

pružamo, prekinite s korištenjem ovih web stranica i web usluga. ITdesk.info team nije odgovoran 

vama, niti trećim osobama za bilo koju nastalu štetu, bila ona direktna, indirektna, slučajna ili 

posljedična, povezana s vašom uporabom ili proizlazila iz vaše uporabe, pogrešne uporabe ovih web 

stranica ili web usluga. Iako vaše potraživanje može biti bazirano na garanciji, ugovoru, prekršaju ili 

nekom drugom pravnom uporištu, neovisno o našoj obaviještenosti o mogućnosti nastanka takve štete, 

oslobađamo se svake odgovornosti. Prihvaćanje ograničenja naše odgovornosti nužan je preduvjet 

korištenja ovih web stranica i web usluga 

Svi softveri navedeni u ovom ili drugim dokumentima objavljenim na stranici ITdesk.info su navedeni 

samo za edukativne svrhe ili kao primjer te mi, na bilo koji način, ne preferiramo navedeni softver u 

odnosu na neki drugi softver. Bilo koju izjavu da neki navedeni softver preferiramo više u odnosu na 

drugi, koji se spominje ili ne spominje u materijalima, smatrat će se kao lažni iskaz. Našu izravnu i 

bezrezervnu podršku imaju jedino softveri otvorenog koda (open source) koji omogućuju 

korisnicima/cama da bez prepreka postanu digitalno pismeni, koriste računalo i sudjeluju u modernom 

informatičkom društvu. 
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